OpenAPI

Disclaimer: page under development

® How to:
® https://data.oceannetworks.ca/OpenAPI
. © Discovery Services: Locations
o Discovery Services: Data Products
© Data Delivery Services
® Request data product (LF - logfile; extension: txt) from CTD at NCBC
® Run data product request(LF - logfile; extension: txt) from CTD at NCBC
= Download data product
© How to get from Oceans3.0 Plotting utility to the scalar data

How to:
https://data.oceannetworks.ca/OpenAPI

® Uses the Oceans 3.0 API web services described here: Oceans 3.0 APl Home
® See below tree structure:
® Each tree item is expandable: displays parameter fields, some default/examples, links to documentation, response field and URL links

Oceans 3.0 Public API

v - OPERATIONS
Discover Locations >
Discover Device Categories >
Discover Deployments >
Discover Properties >
Discover Devices >
Discover Data Products >
Scalar Data >
Raw Data >
Archive File >
Data Product Delivery >

Discovery Services: Locations

® Just use the default settings and hit "Try"


https://data.oceannetworks.ca/OpenAPI
https://wiki.oceannetworks.ca/display/O2A/Oceans+3.0+API+Home

QUERY-STRING PARAMETERS
locationCode
siing | FP0  4—— Default parameter
Return a single Location matching a specific location code.Location Code must be valid and match exactly, including case. Specific Location Codes can be found by simply running
the service without this parameter to get a list of all locations.
Examples: FGPD
deviceCategoryCode
string
Return all Locations that have devices with a specific Device Category Code. DeviceCategoryCodes can be found through the deviceCategory discovery service, see
hittps:/iwiki. ca/display/O2A/deviceC. ies+Discovery+Service for more information

propertyCode
string

Return all Locations that have devices with a sensor with a specific Property Code. Specific Property Codes can be obtained using the properties service, see
hitps:/wi display/O2A/properties+Discovery+Service for more il

dataProductCode
string
Return all of the Locations that support a specific Data Product Code. DataProductCodes can be found through the dataProduct discovery service, see https://wiki.oceannetworks.ca
{display/O2A/dataProducts+Discavery+Service for more i

dateFrom Pattern: Md{4}\d{2) {2} T\d{2} 2} K2 \K)ZS

date-time

Return all of the Locations that have a Deployment Beginning on or after a specific date/time. Dates are formatted yyyy-MM-ddT'HH:mm:ss.SSSZ"
dateTo Pattern: Ad{4}-\H{2\H2) T2} K2} H2PNHB)Z$

date-time
Return all of the Locations that have a Deployment Ending before a specific date/fime. Dates are formatted yyyy-MM-ddTHH:mm:ss.SSS'Z'

locationName
string

Return all of the Locations where the Location Name contains a keyword.

deviceCode
string
Return all of the Locations where a specific device with that Device Code has been deployed. Devices can be found through the device discovery service, see
hitps Jiwiki cafdisplay/O2A/devi Discovery+Service for more in

includeChildren

ean
Return all Devices that are deployed at a specific Location and sub-tree Locations. /

API Server hitps:/idata.oceannetworks.ca/api
Authentication APl Key (token) in query m

® results will be returned as following options:
© JSON formatted response to copy and paste
© CURL - URL response to use in script or browser to query programmatically

Response Status: 0K:200
Took 779 milliseconds CLEAR RESPONSE

RESPONSE RESPONSE HEADERS CURL

"deployments": 47, Cupy
"locationName": "Folger Deep”,

"depth": 96.515085,

"bbox": {

"maxDepth": 105,
"maxLat": 48.8140829,
"maxLon": -125.274604,
"minDepth": 94,
"minLat": 48.813667,
"minLon": -125.28195
I8
"description”: " Folger Deep is a deep location in Folger Passage near a pillar-like seamount, where productivity and marine mommals are observ
"hasDeviceData": "true",
"lon": -125.280577,
"locationCode": "FGPD™,
"hasPropertyData"”: "false”,

Discovery Services: Data Products

® https://data.oceannetworks.ca/OpenAPI - get-/dataProducts
® Discover all data products for a CTD (Conductivity-Temperature-Depth) device at Barkley Canyon Upper slope (locationCode: NCBC)


https://data.oceannetworks.ca/OpenAPI

[BET Returns a location tree

QUERY-STRING PARAMETERS

Discover Device Categories v dataProductCode
string

[GET| Returns a list of device categories

Discover Deployments v .
extension
string
[BET Returns a list of device deployments
Discover Properties v
dataProductName
- Returns a list of properties string
Discover Devices v propertyCode
string
[BET| Returns a list of devices
Discover Data Products v "
locationCode
string

[BET| Returns a list of data products

Scalar Data v
deviceCategoryCode
Returns data from a specific location string
and device category
[BET Returns data from a specific device
deviceCode
Raw Data v string

[BET Returns data from a specific location
and device category

[GET Returns data from a specific device

Archive File v

Return all Data Product Extensions matching a specific Data Product Code.
Examples: HSD

Return all Data Products that have a specific File Extension.
Examples: png

Return all Data Products where the Data Product Name contains a keyword.

Return all Data Products available for a specific Property. Specific Property Codes can be obtained using the properties service, see
/lwiki. I A ties+Discovery+Service for mare

NCBC

Return all Data Products available for a specific Location. Location Code must be valid and match exactly, including case. Specific Location
Codes can be found by simply running the service without this parameter to get a list of all locations.

(ap]

Return all Data Products available for devices belonging to a specific Device Category. DeviceCategoryCodes can be found through the
deviceCategory y service, see I Addevi Discovery+Service for more

Return all Data Products available for a specific Device. Specific Device Codes can be obtained using the Devices service, see
https://wiki. O2A/devices+Discovery+Service for more i

API Server https://data.oceannetworks.ca/api
Authentication API Key (token) in query FILL EXAMPLE CLEAR TRY

®* The response field can be adjusted (expand/compress with corners; scroll within the response field) to view all data products and their

available options.

Discover Properties v

- Returns a list of properties

[BET Returns data from a specific location
and device category

- Returns data from a specific device

- Returns data from a specific location
and device category 1,

[GET| Returns data from a specific device

Archive File v b

Data Delivery Services

Request data product (LF - logfile; extension:

"option":
"suboptions": null

8EH] Returns a location ree RESPONSE RESPONSE HEADERS CURL
Discover Device Categories v Is
- Returns a list of device categories "dataProductCode": "LF",

"dataProductName": "Log File",
Discover Deployments v "dataProductOptions”: [
- Returns a list of device deployments {

"allowableRange": null,
"allowableValues": [

Discover Devices v Yy [
[BET] Returns a list of devices "https://wiki.oceannetworks.ca/display/DP/Data+Gaps"
1,
Discover Data Products v "option": "dpo_dataGaps",
"suboptions": null
| [BET] Returns a list of data products } P
s
Scalar Data v {

"allowableRange": null,
"allowableValues": [

Raw Data v “documentation”: [
"https://wiki.oceannetworks.ca/display/DP/Mobile+Plot+0Options"

“dpo_qualityControl”,

txt) from CTD at NCBC

® https://data.oceannetworks.ca/OpenAPl#get-/dataProductDelivery-request


https://data.oceannetworks.ca/OpenAPI

[ BB rewms @ IsToT vevice:

Discover Data Products v
[GET| Returns a list of data products
Scalar Data v

[GET| Retums data from a specific location
and device category

[BEf] Returs data from a specific device
Raw Data v

- Returns data from a specific location
and device category

[BET] Retums data from a specific device
Archive File v

- Returns archive files from a specific
location and device category

[BER Returns archive files from a specific
device

[GEF] Download an archive file
Data Product Delivery v

[GET| Request a data product

[BET| Check status of a requested data
product

[GET| Run a requested data product
[GE7] Download a data product

QUERY-STRING PARAMETERS

REQUEST

+ FILTER DPO

+ DISPLAY ALL DPO

* dataProductCode | ¢
string
Request a Data Product for a specific Data Product Code. DataProductCodes can
be found through the dataProduct discovery service, see
https:wiki aldisplay/O: for

more information.
Examples: TSSD

* extension

string | txt

Request a Data Product for a specific File Format Extension. Extensions available

for specific Data Product Codes can be obtained programmaticaly from

hitps /Wi adisplay/O: +Service or

interactively from hitps:/wi.oceannetworks.ca/display

102A/Avallable+Data+Products.

Examples: csv

" datefron  223-05-25700:00:00.000 \:'(;');’;‘:”"“’““(2)""‘2)”2’“(2’“"(2"

Return files that have a timestamp on or after a specific dateftime. Dates are
formatted yyyy-MM-dd T'HH:mm:ss.SSS'Z'
Examples: 2019-11-23T00:00:00.000Z
d“stﬁ,lg 2023-05-28T00:00:10.000 \:'(;');’;" MHERHZNHZTHZ}AKZY KN

Return files that have a timestamp before a specific date/time. Dates are formatted
YYyy-MM-ddTHH:mm:ss.SSSZ'
Examples: 2019-11-24T00:00:00.000Z

locationCode

string  NCBC

Request a Data Product from a specific Location. Location Code must be valid and
match exactly, including case. Specific Location Codes can be obtained
from htips:/Awiki aldispla

1y

® Once all required parameters are filled in (* indicated) data product options can be filtered (see arrow)
® The return field indicates the approx. time for the request to run and the file size to be expected from this data request
® The dpRequestld is utilized in the next step

[~ @B Rewms 2 isror devices

Discover Data Products v
[GET| Returns a list of data products
Scalar Data v

BB Retums data from a specific location
and device category

[GET| Returns data from a specific device
Raw Data v

[BET| Retums data from a specific location
and device category

[BEF] Returns data from a specific device
Archive File v

- Returns archive files from a specific
location and device category

[ Retums archive files from a specific
device

[8EH] Download an archive file
Data Product Delivery v

[GE7] Request a data product

[BET| Check status of a requested data
product

[BET] Run a requested data product

[GET] Download a data product

string
Request a Data Product for a specific Property. Property Code must be valid and
match exactly, including case. Specific Property Codes can be obtained
from https:/iwiki display
0 or from
hitps:/wiki a/display/O:

API Server htips://data.oceannetworks.ca/apl
Authentication AP| Key (token) in query

Fu Bz
CLEAR RESPONSE

Response Status: OK:200
Took 646 milliseconds

RESPONSE  RESPONSE HEADERS ~ CURL

{
"Software Developers are implementing estimates of processing tim
1 14497987, -

"16 MB",

“estimatedProcessingTime": "5 s"

}

"disclaimer":

RESPONSE

Run data product request(LF - logfile; extension: txt) from CTD at NCBC

Notes:

https://data.oceannetworks.ca/OpenAPl#get-/dataProductDelivery-run
The page prefills the dpRequestld from your previous step.
You can re-run any requests multiple times by filling in the appropriate dpRequestid.

© the dpRunld is utilized in next step
O the status indicates the process state: queued, completed (hit Try to update status)
o fileCount: indicates how many files to be downloaded


https://data.oceannetworks.ca/OpenAPI#get-/dataProductDelivery-run

[ [@E Returns a list of proporties
DATA PRODUCT DELIVERY [| & APIKey (token)
Discover Devices v

Returns a list of devices
& Run a requested data product

Discover Data Products v N

GET /dataProductDelivery-run
[GET] Returns a list of data products The run method runs the data product created by a cal to the request method. Pressing the iry button again after the run has started will return the runs status.
Scalar Data v REQUEST

[BER Retums data from a specific location

and device category QUERY-STRING PARAMETERS

* dpRequestId
[BER] Returns data from a specific device PRequest st 14497987

A dpRequestld returned from the request service. This field will be auto populated when you press try in the request service
Raw Data v

- 3 API Server htps://data.oceannetworks.ca/ap
[BET| Retums data from a specific location ‘Authentication API Koy (oken) in query FILLEXAMPLE | CLEAR

and device category

’ ) Response Status: Accepted:202
[GET Returs data from a specific device e e Ao EAR RESPONSE
Archive File v RESPONSE RESPONSE HEADERS ~ CURL
[BER Retums archive files from a specific C m

location and device category {
[BET Returs archive files from a specific “dpRunId": 32581245,

device "queuePosition": 1,
8 Download an archive fil FileCount’; 0,

"status”: "queued”
Data Product Delivery v }
]

[GET] Request a data product

[BET| Check status of a requested data

Download data product

® The page prefills the dpRunld from your previous step.
® The index indicates the file number to download: 1 to the number of result files. If index is string meta, metadata file will be downloaded.
® The data product will be automatically downloaded from your browser. It can take a while for the download to complete — be patient.

[ [@E Returns a list of proporties
DATA PRODUCT DELIVERY [} & APl Key (token)
Discover Devices v

[GET] Retums a list of devices
Download a data product

Discover Data Products v N
GET /dataProductDelivery-download

[GET| Returns a list of data products The download method downloads a file for the specified data product run request. The file to download is specified by index, with the first valid index being 1 and the last being the total number
of fles generated by the request. If the data product delivery process has not completed you can periodically press the try button to get current status

Scalar Data v
REQUEST
[BET Returns data from a specific location

S Sovibs CaRgen) QUERY-STRING PARAMETERS

Returns data from a specific device * dpRunId

[ | PRI 32581245

Raw Data v The dpRunld returned from the run service. This field will be auto populated when you press try in the run service
Returns data from a specific location ’ ‘;‘f,ﬁ; 1

and device category
The index of the file to be downloaded, valid values are 1 to the number of result files. If the index is greater than the number of result files a

[GET| Returns data from a specific device response code of 204 is returned, indicating no file at that index. If index is string meta, metadata file will be downloaded

Archive File % API Server fttps:/data.oceannetworks.calapi
Authentication AP Key (token) in query FILL EXAMPLE CLEAR
[BET Returs archive files from a specific

location and device category Response Status: 0K:200 EAR RESPONSE
Took 96 milliseconds

[BER Returns archive files from a specific
device

[GEF] Download an archive file

RESPONSE  RESPONSE HEADERS ~ CURL

RESPONSE
Data Product Delivery v
200
(B Request a data product Downloads the file determined by the index query parameter
[BET| Check status of a requested data EXAMPLE SCHEMA aoolication/ison

How to get from Oceans3.0 Plotting utility to the scalar data

See this video clip for some guidance:https://drive.google.com/drive/folders/1S7-jFsQv3shwDvi9zZ5YdL2cIWtYYwIS?usp=drive_link


https://drive.google.com/drive/folders/1S7-jFsQv3shwDvi9zZ5YdL2clWtYYwlS?usp=drive_link

	OpenAPI

